


UL TRIX Worksystem Software 

Guide to the User Account Manager 

Order Number: AA-PGL4A-TE 

May 1991 

Product Version: ULTRIX Worksystem Software Version 4.2 

Operating System and Version: UL TRIX Version 4.2 

This manual describes how to use the User Account Manager (U AM) software. 

digital equipment corporation 
maynard, massachusetts 



Restricted Rights: Use, duplication, or disclosure by the U.S. Government is subject to restrictions as 
set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at 
DFARS 252.227-7013. 

© Digital Equipment Corporation 1991 
All rights reserved. 

The information in this document is subject to change without notice and should not be construed as a 
commitment by Digital Equipment Corporation. Digital Equipment Corporation assumes no 
responsibility for any errors that may appear in this document. 

The software described in this document is furnished under a license and may be used or copied only in 
accordance with the terms of such license. 

No responsibility is assumed for the use or reliability of software on equipment that is not supplied by 
Digital or its affiliated companies. 

The following are trademarks of Digital Equipment Corporation: 

ALL-IN-I, CDA, DDIF, DDIS, DEC, DECnet, DECstation, DECsystem, DECUS, DECwindows, DTIF, 
MASSBUS, MicroVAX, Q-bus, ULTRIX, ULTRIX Mail Connection, ULTRIX Worksystem Software, 
UNIBUS, VAX, VAXstation, VMS, VT, XUI, and the DIGITAL logo. 

UNIX is a registered trademark of UNIX System Laboratories, Inc. 



Contents 

About This Manual 

Audience vii 

Organization ...................................................................................... vii 

Related Documents .. . . . .. .. .. .. .. .. . .. . .. . .. .. .. .. .. . . .. . . . . . . .. . . .. . .. .. .. .. ... . .. . .. . . . . . . . . viii 

Conventions 

1 Installing and Setting Up UAM 

Installing the UAM Software Subset 

Customizing the UAM Environment .................................................... . 

Setting Up the Login Shell List ................................................... . 
Setting Up the Home Directory Parent List .................................. .. 
Specifying New Account Actions ............................................... .. 
Specifying Account Removal Actions .......................................... . 
Enabling the Unsaved Changes Warning ..................................... .. 
Working With Templates ........................................................... . 

Displaying Templates ........................................................ . 
Creating Templates ............................................................ . 
Removing Templates ......................................................... . 
Modifying Templates ......................................................... . 

Specifying a Lookup Service 
Enabling Automatic Updates 

U sing Profile Files 

viii 

1-1 

1-2 

1-4 
1-5 
1-6 
1-9 

1-10 
1-10 

1-12 
1-12 
1-15 
1-16 

1-17 
1-18 

1-20 



2 Getting Started With UAM 

Invoking UAM 

Using the UAM Window 

U semame Field ......................................................................... . 
Personal Information Fields ........................................................ . 
User ID Field ........................................................................... . 
Login Shell Field ...................................................................... . 
Login Group Field ................................................................... .. 
Secondary Groups ... Button ....................................................... .. 
Parent Field .............................................................................. . 
Name Field ............................................................................. .. 
Disk Quotas ... Button ................................................................ . 
Password ... Button ................................................................... .. 

Changing Lookup Services ................................................................. . 

U sing Log Files ............................................................................... .. 

3 Managing Accounts 

2-1 

2-1 

2-3 
2-3 
2-3 
2-4 
2-4 
2-5 
2-6 
2-7 
2-7 
2-8 

2-10 

2-10 

Listing Login Names .......................................................................... 3-1 

Displaying Account Information .......................................................... 3-2 

Creating Accounts .............................................................................. 3-3 

Removing Accounts 

Modifying Accounts 

Renaming Accounts 

Applying Templates 

Index 

;vContents 

3-5 

3-5 

3-6 

3-7 



Figures 

1-1: UAM Window 

1-2: Login Shell List Dialog Box 

1-3 

1-5 

1-3: Home Directory Parent List Dialog Box ........................................ 1-6 

1-4: New Account Actions Dialog Box ................................................ 1-7 

1-5: Account Removal Actions Dialog Box .......................................... 1-9 

1-6: Unsaved Changes Warning 

1-7: Example of staff Template 

1-8: Template Example ..................................................................... . 

1-9: Template List Dialog Box 

1-10: Password and Group Source Dialog Box .................................... .. 

1-11: Password and Group Source Details Dialog Box .......................... . 

2-1: UAM Window .......................................................................... . 

2-2: Login Shell List Box 

2-3: Login Group List Box 

2-4: Secondary Groups List Box 

2-5: Parent Directory List Box 

2-6: Disk Quotas Dialog Box 

1-10 

1-11 

1-14 

1-15 

1-17 

1-19 

2-2 

2-4 

2-5 

2-6 

2-7 

2-8 

2-7: Password Dialog Box ........... ....................... ................................ 2-9 

2-8: Encrypted Password Dialog Box .................................................. 2-9 

3-1: U sername List Box 

3-2: Defined Remove Actions Dialog Box 

3-2 

3-5 

Contents v 





About This Manual 

This manual provides you with information on how to use the User Account 
Manager (UAM) to display, create, modify, and remove accounts. UAM 
provides a DECwindows interface that allows you to divide your screen into 
windows and select objects with a mouse to simplify account management. 

Audience 
The Guide to the User Account Manager is written for the experienced 
system administrator responsible for installing U AM and customizing the 
UAM environment, and for the less-experienced system administrator 
responsible for managing accounts. 

Organization 
This manual contains the following chapters: 

Chapter 1 Installing and Setting Up UAM 

This chapter explains how to install the UAM subset and how to 
customize the U AM window by setting up lists, specifying default 
actions, and enabling a warning message. It also describes how to 
establish templates, specify a lookup service, enable automatic 
password file and group file updates, and use profile files. This chapter 
is for an experienced system administrator who is familiar with the 
operating system environment. 

Chapter 2 Getting Started With U AM 

This chapter describes how to invoke UAM and how to use the UAM 
main window. It also explains how to change lookup services and 
how to use log files. This chapter is for the less-experienced system 
administrator. 

Chapter 3 Managing Accounts 

This chapter explains how to list login names and how to display, 
create, remove, modify, and rename accounts. It also describes how 
to apply templates. This chapter is for the less-experienced system 
administrator. 



Related Documents 
The DECwindow User's Guide describes how to use DECwindows. The 
Guide to System Environment Setup and the Guide to System and Network 
Setup contain infonnation about some of the account management concepts 
that are discussed in this manual. 

Conventions 
The following conventions are used in this manual: 

# 

user input 

A number sign is the default superuser prompt. 

This bold typeface is used in interactive examples to 
indicate typed user input. 

system output This typeface is used in interactive examples to indicate 
system output and also in code examples and other screen 
displays. In text, this typeface is used to indicate the 
exact name of a command, option, partition, pathname, 
directory, or file. 

filename In examples, syntax descriptions, and function definitions, 
italics are used to indicate variable values. In text, italics 
are used to give references to other documents. 

[ ] In syntax descriptions and function definitions, brackets 
indicate items that are optional. 

eat(l) Cross-references to the ULTRIX Reference Pages include 
the appropriate section number in parentheses. For 
example, a reference to eat (1) indicates that you can 
find the material on the eat command in Section 1 of the 
reference pages. 

I Return I This symbol is used in examples to indicate that you 
must press the named key on the keyboard. 
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Installing and Setting Up UAM 1 

This chapter explains: 

• How to install the U AM software subset 

• How to customize the UAM environment 

• How to use profile files 

Installing the UAM Software Subset 
You can install the UAM software subset when you install the ULTRIX 
operating system or, if you are already running UL TRIX, by using the 
setld command. 

To install the UAM software subset when installing the ULTRIX operating 
system, you must perform an advanced installation. During the installation, 
you are prompted to select the optional software subsets that you want to 
install. The following is a description of the UAM software subset: 
System Management Tools 

For more information about the advanced installation, see the Installation 
Guide for ULTRIX. 

If you are already running ULTRIX, you can use the setld command to 
install the UAM software subset: 

1. Log in as superuser. 

2. Display the status of all the subsets known to the system by using the 
setld command. For example: 
# /etc/setld -i IReturnl 

A table is displayed, listing the name, status, and description of each 
software subset. The following is a description of the UAM software 
subset: 
System Management Tools 

Note the UAM software subset name, which is a string of seven or more 
characters used to uniquely identify the subset. 

3. Load the UAM software subset by using the setld command in the 
following format: 



/etc/setld -I location uam_subseLname 

The lac at i on variable specifies the location of the software 
distribution, which can be a directory, a device special file name, or a 
remote installation server. The uam subset name variable specifies 
the UAM software subset name that you obtained from the setld -i 
command. 

For more infonnation about adding software subsets, see the Guide to the 
System Environment Setup. For more infonnation about the setld 
command, see setld(8) in the ULTRIX Reference Pages. 

Customizing the UAM Environment 
Before you manage accounts with UAM, you can add infonnation to the list 
boxes that are displayed when you click on objects in the UAM window. 
You can also define actions that U AM perfonns when you create and remove 
accounts, enable a warning message that appears when you have unsaved 
account changes, establish templates that contain common infonnation that 
you can apply to accounts, specify a lookup service, and enable automatic 
password file and group file updates. 

To start UAM and open the UAM main window, use the dxuam command. 
The syntax of the dxuam command is shown next. 

dxuam [-p filename] 

If you specify the -p filename option, UAM uses the specified file name 
as the profile file. The default profile file is $HOMEI • uam_profile. For 
more infonnation on profile files, see the section Using Profile Files. 

To obtain online help about the UAM application, use the Help menu in the 
DAM window. 

To exit UAM, choose the Exit item from the File menu in the UAM window. 

Note 

UAM supports only the BSD default security level. 

The UAM window is shown in Figure 1-1. 
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Figure 1-1: UAM Window 

~ lJAM: kaos~L_o_C_'A_L ______________________ ~ __ ~ __ 

File Options Templates Customize Help 

Username &...11 _______ _ II Change/Define II 
Rename 

Remove 

Name 1 ~I ___________ _ 
Office &...11 ___________ _ 

Office Phone I &...I ___________ _ 

Home Phone I &...1 ___________ _ 

User ID II 
Login Shell I Other Shells ... I 
Login Group I Other Groups ... I 

I Secondary Groups ... I 
Home Directory 

Parent I Other Directories ... 

Name II 
:==========::::;: I Disk Quotas ... 

Password ... 

( ...................................................... r··· .. ········· .. ······································ 

I c ... ~()t(~ ! SWy(~ 
!1)(~HH(~d ,~!:('Ollnt i Cnan9f:>S 
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To customize the UAM window, you can do the following: 

• Set up the login shell list box. 

• Set up the parent directory list box. 

• Define actions that UAM performs when you create an account. 

• Define actions that UAM performs when you remove an account. 

• Enable a message that warns you when you have not saved changes. 

• Set up templates. 

• Specify a lookup service. 

• Enable automatic password file and group file updates. 

The following sections describe how to customize the U AM environment. 

Setting Up the Login Shell List 
The login shell is the absolute pathname to the command executed 
immediately upon completion of the login process. For example, after the 
/bin/ csh login shell executes, it reads commands from the. cshrc file 
and then reads commands from the .login file in the account's home 
directory. The /bin/ csh login shell reads commands from the account's 
. logout file when you log out of the account. 

You must specify a login shell for each account. To set up the login shell 
list box, which appears when you click on the Other Shells ... button in the 
UAM window, choose the Login Shell List. .. item from the Customize menu. 
UAM displays the Login Shell List dialog box, an example of which is 
shown in Figure 1-2. 
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Figure 1-2: Login Shell List Dialog Box 

___ Login Shell List _______ ~ __ 

Help 

A login shell can be any 
executable program. 

IIl11ml_ 6 

Ibln/sh 

~ lusr/bin/ksh 

lusr/bln/shS 

il Add II 
I Remove I 

0 

I/bin/cs~ 

I OK II Apply II Cancel I 
ZK-0310U-R 

UAM provides you with four default login shells: /bin/ csh, /bin/ sh, 
/bin/ksh, and /bin/ sh5. You can add and remove login shells to suit 
your needs. 

To add a login shell to the list box, click on the text entry field and type the 
shell name. Then, click on the Add button or press the Return key. 

To remove a login shell from the list box, click on the shell name and then 
click on the Remove button. 

Click on the OK button or the Apply button to apply the changes. 

Click on the Cancel button if you want to cancel the changes. 

Setting Up the Home Directory Parent List 
The account's login directory has two parts: the parent directory and the 
account name. The parent directory, also described as the home directory 
parent, contains the account's home directory. The account name is usually 
the same as the login name that you specify in the U sername field in the 
UAM window. 

For example, when you log in to your account, you are in the following login 
directory: 

parent_directory/name 
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You must specify a parent directory for each account. To set up the parent 
directory list box, which appears when you click on the Other Directories ... 
button in the DAM window, choose the Home Directory Parent List. .. item 
from the Customize menu. DAM displays the Home Directory Parent List 
dialog box, an example of which is shown in Figure 1-3. 

Figure 1-3: Home Directory Parent List Dialog Box 

Help 

<) lusrlstaff 

lusr/users 

/ust"/guest 
~ I Remove! 

I/usr/gues~ 

OK II Apply II Cancel I 
ZK-0311U-R 

DAM provides you with three default parent directories: Ius r 1st a f f, 
lusr/users, and lusr/guest. You can add and remove parent 
directories to suit your needs. 

When you add a parent directory, the directory does not have to exist on your 
system. DAM creates the directory the first time that you specify a login 
directory containing the parent directory. 

To add a parent directory to the list box, click on the text entry field and type 
the parent directory name. Then, click on the Add button or press the Return 
key. 

To remove a directory from the list box, click on the parent directory name 
and then click on the Remove button. 

Click on the OK button or the Apply button to apply the changes. 

Click on the Cancel button if you want to cancel the changes. 

Specifying New Account Actions 
DAM allows you to specify the actions that it performs when you enter a 
new login name in the Dsemame field in the DAM window. DAM will then 
enter values in some of the text entry fields; you can then edit the values as 
needed. 
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You can specify that UAM perform one or more of the following actions: 

• Clear any information in the personal information fields 

• Enter the next available user ID in the User ID field 

• Enter the login name in the home directory Name field 

• Apply the values in a specified template to the account 

To specify the actions UAM performs when you create an account, choose 
the New Account Actions ... item from the Customize menu. UAM displays 
the New Account Actions dialog box, as shown in Figure 1-4. 

Figure 1-4: New Account Actions Dialog Box 

@ Clear personal Information fields 
@ Display next available user ID 

Help 

@ Display username in home directory name field 

o Display template values lather Templates ... 

OK II Apply II Cancel I 
ZK-0312U-R 

When you start UAM for the first time, all the actions are enabled, and the 
staff template is specified in the dialog box. 

If the Clear personal information fields button is enabled, UAM clears any 
information that is in the personal information fields. 

If the Display next available user ID button is enabled, UAM enters a UAM
generated user ID in the User ID field. 

If the Display usemame in home directory name field button is enabled, 
U AM enters the login name you specified in the U semame field in the Name 
field. 

If the Display template values button is enabled, UAM applies the specified 
template to the account. To display the available templates, click on the 
Other Templates ... button; a list box, similar to the following, containing the 
available templates, is displayed: 
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staff 

group 

temp 

Cancel I 

To select a template, click on the template name and then click on the OK 
button, or double click on the template name. The list box is dismissed, and 
the template name is displayed in the New Account Actions dialog box. The 
following is an example of the New Account Actions dialog box with a 
template selected: 

(f) Clear personal information fields 
(f) Display next available user ID 

Help 

(f) Display username in home directory name field 
o Display template values I'--st_a_ff _____ --' 

OK II Apply II Cancel I 

If you want to change the selected template or view the list of available 
templates, click on the template name in the dialog box. An option menu, 
similar to the following, containing the available templates, is displayed: 

(f) Clear personal information fields 
(f) Display next available user ID 
(f) Display usernam 
o Display template 

OK 

e in hom 
values I 

I Apply 

staff 

I temp 

group 
II ""..,..""'~ 

Help 

I 

• 
After you specify the new account actions, click on the OK button or the 
Apply button to apply the changes. 

Click on the Cancel button if you want to cancel the changes. 
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Specifying Account Removal Actions 
UAM allows you to specify actions that it performs when an account is 
removed. You can specify that UAM perform one or more of the following 
actions: 

• Disable the account 

• Remove the account's entries in the password and group files 

• Remove the account's home directory and its files 

To specify the actions that UAM performs when it removes an account, 
choose the Account Removal Actions... item from the Customize menu. 
UAM displays the Account Removal Actions dialog box. The Account 
Removal Actions dialog box is shown in Figure 1-5. 

Figure 1-5: Account Removal Actions Dialog Box 

Help 

@ Disable the account 
@ Remove password and group files entries 
<It Remove the home directory and its files 

OK II Apply II Cancel I 
ZK-0313U-R 

When you start UAM for the first time, only the Disable the account action is 
enabled. 

If you enable the Disable the account button, the second field of an account's 
entry in the password file is replaced by NO_LOGIN. 

If you enable the Remove password and group files entries button, an 
account's entries in the password and group source files are removed. For 
more information about password and group source files, see the section 
Enabling Automatic Updates. 

If you enable the Remove the home directory and its files button, the 
account's home directory and any files it contains are removed. 

After you specify the account removal actions, click on the OK button or the 
Apply button to apply the changes. 

Click on the Cancel button if you want to cancel the changes. 
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Enabling the Unsaved Changes Warning 
When you manage accounts with UAM, you must be sure to save the 
changes that you make to an account. If you do not click on either the 
Create Defined Account button or the Save Changes button in the UAM 
window before you manage another account, the changes you made are lost. 

UAM allows you to specify an option that displays the warning message 
shown in Figure 1-6 when you try to manage an account without saving 
changes made to a previous account. 

Figure 1-6: Unsaved Changes Warning 

o 
The current account has been edited. 

Do you want to forget the edits and continue? 

~ GJ I Cancel I 

To enable the warning message, choose the Display Unsaved Edits Warnings 
item from the Customize menu. A shaded button appears next to the menu 
item when the option is enabled. 

Working With Templates 
With UAM you can establish templates to specify account information in the 
UAM window fields. Templates allow you to quickly create accounts with 
common information because the common information is part of the 
template. For example, you can create a template that contains information 
common to a general purpose account, such as a particular login shell, login 
group, secondary group, and parent directory. 

Initially, UAM provides you with three templates: staff, users, and guest. 
These templates contain the following account information: 

• The Ibinl csh login shell 

• Either the staff, users, or guest login group 

• Either the lusr I staff, lusr lusers, or lusr I guest parent 
directory 

The staff template is shown in Figure 1-7. 
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Figure 1-7: Example of staff Template 

File Options Templates Customize Help 

Username 1.-1 _____ _ , Change/Define II 
I Rename I 
I Remove I 

Name II 
Office II 
Office Phone II 
Home Phone II 

User 10 II 
Login Shell 

Login Croup 

I /bin/csh 

I staff 

I Secondary Croups... I 
Home Directory 

Parent I /usr/staff I 
Name II :===========, I Disk Quotas... I 

Password ••• 

s<W(~ 
<:hang.~s I 

You can modify or remove the templates to suit your needs. You can create 
as many templates as you want. 

You apply a template to an account by entering a login name in the 
Usemame field and choosing the template name from the Templates menu in 
the UAM window. The template information is displayed in the UAM 
window fields. The template information may override information that is 
already specified in a field. 

You can apply a template to all new accounts by specifying the template 
name in the New Account Actions dialog box. For more information, see the 
section Specifying New Account Actions. 
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Displaying Templates 

You can display the information contained in a template before you apply it 
to an account. To display a template, perform the following steps: 

1. If information is specified in the UAM window fields, delete any 
information in the U semame field and press the Return key. 

UAM displays a message box; dismiss the message box to clear the 
fields. 

2. Choose the name of the template you want to display from the Templates 
menu. 

The template information is displayed in the fields in the UAM window. 

Creating Templates 
To create a template, perform the following steps: 

1. If information is specified in the UAM window fields, delete any 
information in the Usemame field and press the Return key. 

UAM displays a message box; dismiss the message box to clear the 
fields. 

2. Enter the information for the template in the UAM window fields. For 
information about the UAM window fields, see Chapter 2. 

You can enter values for all of the fields except the Username, User ID, 
and Name fields because these values must be unique for every account. 
You can specify information about secondary groups, disk quotas, and 
passwords by clicking on the appropriate buttons and entering 
information in dialog boxes. 

When you create a template, leave a field empty or select 
<BLANK selection> from a list box if you do not want to overwrite any 
information that is already specified in the field when you apply the 
template. 

3. Choose the Template List ... item from the Customize menu. 

UAM displays the Template List dialog box. 

4. Click on the text entry field in the Template List dialog box and type a 
name for the template; then click on the Add button or press the Return 
key. 

The template name is added to the list box. 

5. Click on the OK or the Apply button to apply the changes. 

The name of the template you created appears as an item in the 
Templates menu and in the list box you access from the New Account 
Actions dialog box. 
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Caution 
Because of a bug in the DAM software, the Template List 
dialog box does not work correctly. When you click on the 
OK or the Apply button, UAM does not update the 
$HOME/ . uamyrofile file to reflect the template 
changes. Therefore, you must use another UAM 
customization feature to update the file. The easiest way to 
do this is to toggle the Display Unsaved Edits Warning item 
in the Customization window. 

Click on the Cancel button if you want to cancel the changes. 

An example of a UAM window and a Secondary Groups dialog box with 
template information entered is shown in Figure 1-8. 
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Figure 1-8: Template Example 

~ 
Rename 

o authread 
fII bin Remove 
o daemon 
o Ingres 
Okmem 

Nam o news 
III operator 
Oris M 

o rsrv3 

Hom o rsv9 
.... 
'0 

Login Shell /bln/csh 

Login Croup I rsv9 I 
Secondary Croups •.. I 

Home Directory 

Parent < BLANK selection> 

Name II 
I Disk Quotas ... 

Password ... 

r···············(;:·~;·;~1:~~················· [""·················s·~:~·~;·············""·· 

jI)(~f"hl(~d Ae( o lint i Ch()n9.~s 

An example of a Template List dialog box is shown in Figure 1-9. 
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Figure 1-9: Template List Dialog Box 

_ Template List [g 
Help 

Specify the template values in 
the UAM window before adding the 

template name to the list. 

staff 

users 

<) 

~ I Remove I guest 

temp 

Item~ 

OK II Apply II Cancel 

ZK-0309U-R 

Removing Templates 

To remove a template, perform the following steps: 

1. Choose the Template List... item from the Customize menu. 

UAM displays the Template List dialog box. 

2. Click on the name of the template you want to remove; then click on the 
Remove button. 

The template name is removed from the list box. 

3. Click on the OK or the Apply button to apply the changes. 

The name of the template you removed is deleted from the Templates 
menu and from the list box you access from the New Account Actions 
dialog box. 

Caution 

Because of a bug in the UAM software, the Template List 
dialog box does not work correctly. When you click on the 
OK or the Apply button, DAM does not update the 
$HOMEI . uam_profile file to reflect the template 
changes. Therefore, you must use another UAM 
customization feature to update the file. The easiest way to 
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do this is to toggle the Display Unsaved Edits Warning item 
in the Customization window. 

Click on the Cancel button if you want to cancel the changes. 

Modifying Templates 

To change the information contained in a template, perfonn the following 
steps: 

1. Display the template that you want to modify. For more infonnation, see 
the section Displaying Templates. 

2. Edit the fields in the UAM window as needed. For infonnation about the 
UAM window fields, see Chapter 2. 

3. Once the template infonnation is correct, choose the Template List... item 
from the Customize menu. 

UAM displays the Template List dialog box. 

4. Click on the name of the template you want to modify. 

5. Click on the Remove button to remove the template name from the list 
box. 

6. Click on the text entry field and type the name of the modified template. 
The template name can be the same as the one you deleted in the 
previous step, or it can be a different name. 

7. Click on the Add button or press the Return key. 

8. Click on the OK or the Apply button to apply the changes. 

Caution 

Because of a bug in the UAM software, the Template List 
dialog box does not work correctly. When you click on the 
OK or the Apply button, UAM does not update the 
$HOME/ . uam_profile file to reflect the template 
changes. Therefore, you must use another UAM 
customization feature to update the file. The easiest way to 
do this is to toggle the Display Unsaved Edits Warning item 
in the Customization window. 

Click on the Cancel button if you want to cancel the changes. 
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Specifying a Lookup Service 
UAM manages the local accounts on your system. In addition, if your 
system serves Yellow Pages (YP) or BIND/Hesiod (BIND) accounts, UAM 
can manage accounts by using those lookup services. The service you are 
using is shown at the top of the U AM window. When you use U AM for the 
first time, the default local service is used. 

You can specify that UAM use another service by choosing the Password and 
Group Source ... item from the Customize menu. UAM displays the 
Password and Group Source dialog box, an example of which is shown in 
Figure 1-10. 

Figure 1-10: Password and Group Source Dialog Box 

Source Details 

Host Name 

Service 

Help 

kaos 

I LOCAL 

o Update Password and Group Source Automatically 

OK II Apply II Cancel 

ZK-0308U-R 

To display the services available on your system, click on the entry in the 
Service field. A menu appears, allowing you to select the service you want. 
Services that are unavailable are dimmed. The following is an example of a 
service menu with local and YP services available: 
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Source Details Help 

Host Name !.~~-

LOCAL 
Service II Vp II 

1:INO 

o Update Password and Group Source Automatically 

OK II Apply II Cancel I 

The service you select is reflected in the default profile file, so when you use 
the dxuam command without the -p option, UAM uses the selected service 
to manage accounts. You can specify a different service in an optional 
profile file to use that service to manage accounts. For more information, see 
the section Using Profile Files. 

Enabling Automatic Updates 
When you manage accounts with UAM, you must update the system 
password and group files to convert the files into a database that the service 
(local, YP, or BIND) can use. You must update the files before you end a 
UAM management session or the changes will be lost. However, you do not 
have to update the files each time you apply changes. 

Note 

It is recommended that, instead of updating the files 
automatically, you choose the Update Password and Group 
Source item from the Options menu after you finish managing 
accounts. This is because of the time it takes to convert the files 
into a database. 

If you enable the Update Password and Group Source Automatically button 
in the Password and Group Source dialog box, shown in Figure 1-10, UAM 
updates the password and group files each time you click on the Create 
Defined Account button, the Save Changes button, the Remove button, or the 
Rename button. 

To show the password and group file names and the update commands, 
choose the Show ... item from the Source Details menu in the Pass word and 
Group Source dialog box. UAM displays the Password and Group Source 
Details dialog box. Each service uses different commands to update its 
database. An example of a Password and Group Source Details dialog box 
for local service is shown in Figure 1-11. 
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Figure 1·11: Password and Group Source Details Dialog Box 

Password File 

File Name: /etc/passwd 

Update Command: /etc/mkpasswd -u /etc/passwd 

Group File 

File Name: /etc/group 

Update Command: 

Cancel 
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Note that there is no update command for the local service's group file. 

The following is an example of a Password and Group Source Details dialog 
box for YP service: 

Password File 

File Name: /var/vp/src/passwd 

Update Command: !bin/make -f /var/vp/Makefile passwd 

Group File 

File Name: /var/vp/src/group 

Update Command: /bin/make -f /var/vp/Makefile group 

Cancel 

Click on the Cancel button to dismiss the dialog box. 
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Using Profile Files 
DAM uses a profile file to determine the DAM environment. When you 
customize the DAM environment, the default profile file 
$HOME/ . uam_profile reflects the customization. Each time you modify 
the customization, the default profile file is updated with the changes. UAM 
uses the default profile file if you specify the dxuam command without the 
-p option. 

You can create profile files if you want to use different DAM environments 
to manage accounts. To do this, copy the file $HOME/ . uam profile to 
another file and edit the new file as needed. When you invoke UAM, specify 
the new file name by using the dxuam command with the -p option. For 
more information on the format of the dxuam command, see the section 
Customizing the DAM Environment. 

You can override the default profile file directory and file name by redefining 
the environmental variable DAM PROFILE. 

The following is an example of a profile file: 
flag.execute_update_cmds_auto: 0 
flag.display_unsaved_edits_warnings: 
uam database valid: TRUE - -

[1] 
o 

new_user_default_value.get_next_available_userID: 
new_user_default_value.homedir_name_is_username: 
new_user_default_value.clear-Fersinfo_fields: 1 
new_user_default_value.use_template: 0 @ 
new user default value.template name: 
template=names: staff ~ -
homedir hosts: localhost 
homedir~ardirs.localhost: /usr/staff,/usr/users 
login_shells: /bin/csh,/bin/sh ~ 
template.staff.pardir: /usr/staff 
template.staff.logingr: users 
template.staff.loginsh: /bin/csh 
template.staff.username: 
template.staff.userid: 
template.staff.homedir: 
template.staff.secondary_groups: operator,system 
template.staff.diskquo_blocks_soft_limit: 
template.staff.diskquo_blocks_abs_limit: 
template.staff.diskquo_files_soft_limit: 
template.staff.diskquo_files_abs_limit: 300 
pwd_gr_source.host_name: kaos 
pwd_gr_source.domain_name: Local 
rem_acts_value.disable_acct_only: 
rem_acts_value.remove-Fwd_gr_ents: 
rem_acts_value.remove_home_and_files: 

1 
1 
1 

5000 
6000 
250 

1 
1 [3] 

In this example, the UAM environment has the following characteristics: 
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[J The Update Password and Group Source Automatically button in the 
Password and Group Source dialog box is disabled. 

I2l The Display Unsaved Edits Warnings option is disabled. 

l3J The following default actions for new accounts are enabled: 

- Display next available user ID 

- Display username in home directory name field 

- Clear personal information fields 

~ The following default action for new accounts is disabled: 

- Display template values 

Note that no default template name is shown. 

!§] The name of the available template is "staff." 

I§) The names of the available parent directories are /usr / staff and 
/usr/users. 

III The names of the available login shells are /bin/ csh and /bin/ sh. 

~ For the staff template, the home directory parent, the login group, the 
login shell, and the secondary groups are /usr / staff, users, 
/bin/ csh, and operator and system, respectively. The soft block 
limit, absolute block limit, soft file limit, and absolute file limit disk 
quotas are 5000, 6000, 250, and 300, respectively. 

Ii] For host kaos, the default service is local. 

[OJ The following default actions for removing accounts are enabled: 

- Disable the account 

- Remove the password and group files entries 

- Remove the home directory and its files 
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Getting Started With UAM 2 

This chapter explains how to invoke the U AM application and how to exit 
from U AM. It also explains how to enter information in the U AM window 
fields, how to change services, and how to use log files. 

Invoking UAM 
To invoke UAM, use the dxuam command. The syntax of the dxuam 
command is shown next. 

dxuam [ -p filename] 

The -p filename option specifies that filename be used as the profile 
file. The profile file determines the UAM environment. If you do not 
specify the -p option, the default profile file $HOME/ . uam_profile is 
used. For more information on customization and profile files, see Chapter 1. 

To obtain online help on the UAM application, use the Help menu in the 
UAM window. 

To exit U AM, choose the Exit item from the File menu. 

Using the UAM Window 
The UAM window, shown in Figure 2-1, provides a simple format in which 
you enter account infonnation. The following sections describe the fields in 
the UAM window and how to enter information in the fields. 



Figure 2-1: UAM Window 

~ UAM: kaos/Loc_A_L _____________________ ~ __ ~ __ 

File Options Templates Customize Help 

usernamel L..,I _______ _ II Change/Define II 

Name 

Office 

Office Phone 

Home Phone 

UserlD 

Login Shell 

Login Croup 

II 
II 
II 
II 

Home Directory 

Rename 

Remove 

II 
Other Shells... I 
Other Croups... I 
Secondary Croups... I 

Parent I Other Directories ... 

Na~ I~I ____________ _ 
I Disk Quotas ... 

Password ... 

t···· .. ············· .. ··· .. ·· .. ········ .. · .. ·········•· t··· .. · .. ················· .. ········ .. ···· .. ··· .. ······ 
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Jsername Field 
The Username field is where you specify a unique login name for each 
account. 

To specify a login name, click on the U sername text entry field, type the 
login name, and press the Return key. 

Personal Information Fields 
The personal infonnation fields are where you, optionally, enter the following 
personal infonnation about the owner of the account: 

• Name 

• Office location 

• Office telephone number 

• Home telephone number 

To specify personal infonnation, click on the appropriate text entry field, type 
the infonnation, and press the Return key. 

If you want to clear any infonnation in the personal infonnation fields, 
choose the Clear Personal Infonnation Fields item from the Options menu in 
the UAM window. 

User 10 Field 
The User ID field is where you specify the user ID for the account. The user 
ID detennines a user's identity, identifies the user's processes, and 
detennines the owner's access pennission to files. This number must be 
unique for each user and should be less than 32000. 

To specify a user ID, click on the User ID text entry field in the UAM 
window, type the number, and press the Return key. 

Note 

You should not specify 0 for a user ID because the account will 
have root privileges. 

You can specify the next available user ID on the system by choosing the 
Display Next Available User ID item from the Options menu in the UAM 
window. 
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Login Shell Field 
The login shell is the absolute pathname to the command executed 
immediately upon completion of the login process. For example, after the 
/bin/ csh login shell executes, it reads commands from the. cshrc file 
and then from the .login file in the account's home directory. The 
/bin/ csh login shell reads commands from the account's .logout file 
when you log out of the account. 

To display the list of available login shells, click on the Other Shells ... button 
in the UAM window. If a value is already specified in the field, click on the 
field. UAM displays the login shell choices in a list box, an example of 
which is shown in Figure 2-2. 

Figure 2-2: Login Shell List Box 

< BLANK selection> 6-

Ibin/csh 

~ Ibin/sh 

lusr/bin/ksh 

lusr/bin/sh5 Q 

II OK III Cancel I 
To specify a login shell, select the shell name in the list box and click on the 
OK button, or double click on a shell name. 

Note 
You cannot specify <BLANK selection> for an account's login 
shell because it is used only by templates. 

Click on the Cancel button if you want to cancel the changes. 

For information on setting up the login shell list box, see Chapter 1. 

Login Group Field 
The login group is the account's primary group. When you log in to an 
account, the process is marked with the login group and secondary groups 
that you belong to. Because your home directory is marked with the login 
group, all files you create in your home directory belong to that group. UAM 
obtains the login groups from the system group file. 
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To display the list of available login groups, click on the Other Groups ... 
button in the UAM window. If a value is already specified in the field, click 
on the field. UAM displays the login group choices in a list box, an example 
of which is shown in Figure 2-3. 

Figure 2-3: Login Group List Box 

< BLANK selection> 6 

authread 

~ bin 

daemon 

guest <:7 

II OK III Cancel I 
To specify a login group, select the group name in the list box and click on 
the OK button, or double click on a login group name. 

Note 

You cannot specify <BLANK selection> for an account's login 
group because it is used only by templates. 

Click on the Cancel button if you want to cancel the changes. 

Secondary Groups ... Button 
Secondary groups can be used to restrict access to a project work area. Like 
login groups, secondary groups are obtained from the system group file. 
Secondary groups for an account are optional. 

To display the list of available secondary groups, click on the Secondary 
Groups ... button in the UAM window. UAM displays the secondary group 
choices in the Secondary Groups list box, and example of which is shown in 
Figure 2-4. 
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Figure 2·4: Secondary Groups List Box 

Help 

o Ingres 6-,..., 
Dkmem 
Dnews ....... 

o operator 
Ij] ris 
o rsrv3 
o rsv9 
Ij] system 
o tty 

1= o uucp 0 

OK II Apply II Cancel I 
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To specify a secondary group or groups, click on the group or groups in the 
list box and click on the OK button or the Apply button. 

Click on the Cancel button if you want to cancel the changes. 

Parent Field 
An account's login directory has two parts: the parent directory and the 
account name. The parent directory, also described as the home directory 
parent, contains the account's home directory. The account name is usually 
the same as the login name you specify in the Dsemame field. 

For example, when you log in to your account, you are in the following login 
directory: 

parent_directory/name 

To display the list of available parent directories, click on the Other 
Directories ... button in the DAM window. If a value is already specified in 
the field, click on the field. DAM displays the parent directory choices in a 
list box, an example of which is shown in Figure 2-5. 
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Figure 2-5: Parent Directory List Box 

< BLANK selection> () 

/usr/staff 

~ /usr/users 

fun/guest 

0 

II OK III Cancel I 
To specify a parent directory, select the parent directory name in the list box 
and click on the OK button, or double click on a parent directory name. 

Note 

You cannot specify <BLANK selection> for an account's parent 
directory because it is used only by templates. 

Click on the Cancel button if you want to cancel the changes. 

For information on setting up the parent directory list box, see Chapter 1. 

Name Field 
The account name completes the account's login directory path, for example: 

parent_directory/name 

The name of the account's home directory is usually the same as the login 
name you specify in the Username field. The name must be unique for each 
account. 

To specify a name, click on the Name text entry field, type the name, and 
press the Return key. Note that if the Display username in home directory 
name field option is enabled in the New Account Actions dialog box, the 
login name specified in the Username field will be entered in the Name field 
each time you create an account. For information on the New Account 
Actions dialog box, see Chapter 1. 

Disk Quotas ... Button 
Disk quotas enable you to manage disk space by setting limits on the number 
of files and disk blocks an account can use. UAM allows you, optionally, to 
specify disk quotas for the file system that contains the account's home 
directory. 
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Note 

If you want to establish disk quotas for an account with U AM, 
you must edit the / et c / f stab file so that the entry for the file 
system that contains the account's home directory is changed to 
rq mount type (read-write with quotas). For more information 
about establishing disk quotas on file systems, see the Guide to 
System and Network Environment. 

To establish disk quotas, click on the Disk Quotas ... button in the UAM 
window. UAM displays the Disk Quotas dialog box, as shown in Figure 2-6. 

Figure 2-6: Disk Quotas Dialog Box 

___ o~~ 
Help 

Files Blocks 

Current Usage 1-10 ____ ....J11-10 ____ .......I 

Soft limit II II-I ____ _ 
Absolute limit II II-I ____ _ 
Remaining 1.1 IY.i Login Warnings . 1-. ____ _ 

OK II Apply II Cancel I 
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For an existing account, the Disk Quotas dialog box displays infonnation 
about the account's disk use in the Current Usage fields. 

To specify disk quotas, click on the appropriate text entry fields and type the 
soft and absolute limits for files and for blocks. To specify the number of 
times you can log in to an account once the soft limit is reached, click on the 
Remaining Login Warnings text entry fields and type the numbers. 

Click on the OK button or the Apply button to apply the changes. 

Click on the Cancel button if you want to cancel the changes. 

Password ... Button 
The Password ... button is used to specify the password for the account. 

2-8 Getting Started With UAM 



Click on the Password ... button in the UAM window to display the Password 
dialog box, as shown in Figure 2-7. 

Figure 2-7: Password Dialog Box 

--
Help 

New Password '-11 _______ _ 

Retype New Password 1-11 _______ _ 

1 Encrypted Password ... 

OK II Apply II Cancel I 
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To specify a password, click on the New Password text entry field, type the 
password, and press the Return key. Then, type the same password in the 
Retype New Password field and press the Return key. 

Note 

For security reasons, the password itself is never displayed on 
your terminal. 

Click on the OK button or the Apply button to apply the changes. 

Click on the Cancel button if you want to cancel the changes. 

DAM gives you the option of specifying an encrypted password for an 
account. An encrypted password can be used to disable an account. If you 
want to specify an encrypted password, click on the Encrypted Password ... 
button. DAM displays a dialog box, as shown in Figure 2-8. 

Figure 2-8: Encrypted Password Dialog Box 

Encrypted Password 11...-1 _______ _ 

Click on the text entry field and type the password. Then, either click on the 
OK button or press the Return key. 
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Changing Lookup Services 
DAM manages the local accounts on your system. In addition, if your 
system serves Yellow Pages (YP) or BIND/Hesiod (BIND) accounts, DAM 
can manage accounts by using those lookup services. The service you are 
using is shown at the top of the DAM window. 

You can specify that DAM use another service by choosing the Password and 
Group Source ... item from the Customize menu. For information on 
specifying a lookup service, see Chapter 1. 

Using Log Files 
During a DAM session, a log file is created that records the DAM account 
changes that have succeeded and those that have failed. You can use the log 
file to determine the state of your session if a failure occurs; the log file 
shows what operations were aborted because of the failure. 

The location and filename for the default log file is $HOME/ . uam_log. 

The log file only applies to the current management session; if you start 
another session, the log file from the first session is moved to 
$HOME/.uam_log.bak. 

You can override the default log directory $HOME by redefining the 
environmental variable DAM LOG D I R • 

The following is a sample log file: 
***UAM run at Mon Nov 12 12:02:32 EST 1990 on kaos by root 
passwd file connect - SUCCEEDED 

node = kaos 
file name = /etc/passwd 
update cmd = /etc/mkpasswd -u /etc/passwd 

group file connect - SUCCEEDED 
node = kaos 
file name = /etc/group 
update cmd = 

Add "tai" 
Add: Start 
Add: Adding entry to passwd file - SUCCEEDED 
Add: Creating home directory /usr/r1/tai gid 
Add: Adding user to groups () - SUCCEEDED 
Add: End (SUCCEEDED) 

31 uid 

Perform update command on passwd file - SUCCEEDED 
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Managing Accounts 3 

This chapter explains how to use UAM to display a list of account login 
names and how to display, create, remove, modify, and rename accounts. 

Note 

To apply account changes to the system, you must update the 
system password and group files. For more information on 
updating the files, see Chapter 1. 

Listing Login Names 
The login name for an account is specified in the Usemame field in the UAM 
window. To list the login names for all the accounts on your system, choose 
the List Accounts ... item from the Customize menu. UAM displays the 
Usemame List list box, an example of which is shown in Figure 3-1. 



Figure 3-1: Username List Box 
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Displaying Account Information 
You can display the information associated with an account by clicking on 
the Username field in the UAM window, typing the login name, and pressing 
the Return key. The account information is displayed in the U AM window. 

You can also display account information by selecting the account's login 
name in the Username List list box. 

The following is an example of the U AM window with account information 
displayed: 
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[ij UAM: kaoS/lO_C_Al _____________________ ~ __ ~_ 

File Options Templates Customize Help 

Username L-I c_h_e~~T _____ _ II Change/Define II 
Rename 

Remove 

Name IL-J_Oh_n_C_h_e_~ _______ _ 

Office 1'-3_X_O_~ ________ _ 

Office Phone 11-198~ 
~----------

Home Phone IL-I __________ _ 

User ID 1L-1_0_2Z...;;,: ______ _ 

Login Shell L-I .:..../b.:....l...,;n/:.....c __ s __ h ____ ---J 

login Croup I system 

~========: Secondary Groups ••• 

Home Directory 

Parent I /usr/staff 

Name I,-c_h_en_~ ______ _ 

r···············i;·i~·k···(i·;·;·;;1:~~~·:·:·:· .. ····· .. ········1 

Password ••• 

Save 
Changes 

Creating Accounts 
To create a new account, perform the following steps: 

1. Type the login name for the account you want to create in the U semame 
field. 
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Note 

You should not specify the login names root and daemon. 

2. Click on the Change/Define button or press the Return key. 

UAM may then enter some values in the UAM window fields, depending 
on what new account actions were specified. For more infonnation on 
the new account actions, see Chapter 1. 

3. Edit the fields as necessary. 

You must specify information in the Usemame, User ID, Login Shell, 
Login Group, Parent, Name, and Password fields for each account. For 
information about the UAM window fields, see Chapter 2. 

You also can do the following: 

• Enter the next available user ID in the User ID field by choosing the 
Display Next Available User ID item from the Options menu. 

• Apply the values contained in a template by choosing a template 
name from the Templates menu. For more information, see the 
section Applying Templates. 

Note 

To reset the UAM window fields to their original values, 
click on the Change/Define button. 

4. When the information in the UAM window is correct, click on the Create 
Defined Account button. 

The following message is displayed when the account is successfully 
created: 

The account was successfully created. 

II Acknowledged II 

5. If the Update Password and Group Source Automatically button in the 
Password and Group Source dialog box is not enabled, you must update 
the password and group files. To update the files, choose the Update 
Password and Group Source item from the Options menu after you finish 
your account management session. For more information about password 
and group files, see Chapter 1. 
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Removing Accounts 
To remove an account, perform the following steps: 

1. Type the login name for the account you want to remove in the Username 
field. You can also choose the List Accounts ... item from the Options 
menu and then select the login name in the Username List list box. 

2. Click on the Remove button. 

U AM displays the Defined Remove Actions dialog box, which shows the 
actions U AM will perform if you decide to remove the account. 

An example of a Defined Remove Actions dialog box is shown in 
Figure 3-2. 

Figure 3-2: Defined Remove Actions Dialog Box 

Defined Remove Actions 

Account will be disabled. 
Password and group file entries will be removed. 
The home directory and its files will be removed. 

I Remove III Cancel II 

3. Click on the Remove button in the Defined Remove Actions dialog box. 

4. If the Update Password and Group Source Automatically button in the 
Password and Group Source dialog box is not enabled, you must update 
the password and group files. To update the files, choose the Update 
Password and Group Source item from the Options menu after you finish 
your account management session. For more information about password 
and group files, see Chapter 1. 

Modifying Accounts 
To modify an account, perform the following steps: 

1. Display the account you want to modify in the UAM window. For 
information about displaying accounts, see the section Displaying 
Account Information. 

2. Edit the UAM window fields as needed. For information about entering 
information in the fields, see Chapter 2. 

You also can apply a template to the account. For infonnation about 
using templates, see the section Applying Templates. 
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Note 

To reset the UAM window fields to their original values, 
click on the Change/Define button. 

3. When the infonnation in the U AM window is correct, click on the Save 
Changes button to save the modifications you made to the account. 

4. If the Update Password and Group Source Automatically button in the 
Password and Group Source dialog box is not enabled, you must update 
the password and group files. To update the files choose the Update 
Password and Group Source item from the Options menu after you finish 
your account management session. For more infonnation about password 
and group files, see Chapter 1. 

Renaming Accounts 
To change the login name for an account, perfonn the following steps: 

1. Type the login name for the account you want to rename in the Username 
field in the UAM window. You also can choose the List Accounts ... item 
from the Options menu and then select the login name in the U sername 
List list box. 

2. Click on the Rename button. 

3. UAM displays the following dialog box: 

New Username 1 ..... 1 _______ _ 

Cancel 

Type the new login name in the New Username text entry field and either 
click on the Rename button or press the Return key. 

4. If the Update Password and Group Source Automatically button in the 
Password and Group Source dialog box is not enabled, you must update 
the password and group files. To update the files, choose the Update 
Password and Group Source item from the Options menu after you finish 
your account management session. For more infonnation about password 
and group files, see Chapter 1. 
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Applying Templates 
You can apply template information to an account to make account 
management easier. When you apply a template, values are specified in 
some of the UAM window fields. For information on working with 
templates, see Chapter 1. 

To apply template information to an account, perform the following steps: 

1. Type the login name for the account in the Usemame field in the UAM 
window and press the Return key. If the account already exists, you can 
also choose the List Accounts ... item from the Options menu and then 
select the login name in the U semame List list box. 

2. Choose the template name from the Templates menu. 

The template information is entered in some of the UAM window fields. 
Note that information you previously specified in a field may be 
overwritten by a template value. 

3. Edit the fields as needed. For more information on the DAM window 
fields, see Chapter 2. 

Note 

To reset the UAM window fields to their original values, 
click on the Change/Define button. 

4. Once the account information in the UAM window is correct, click on the 
Create Defined Account button if you are creating an account or click on 
the Save Changes button if you are modifying an account. 

5. If the Update Password and Group Source Automatically button in the 
Password and Group Source dialog box is not enabled, you must update 
the password and group files. To update the files, choose the Update 
Password and Group Source item from the Options menu after you finish 
your account management session. For more information about password 
and group files, see Chapter 1. 
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How to Order Additional Documentation 

Technical Support 
If you need help deciding which documentation best meets your needs, call 800-343-4040 
before placing your electronic, telephone, or direct mail order. 

Electronic Orders 
To place an order at the Electronic Store, dial 800-234-1998 using a 1200- or 2400-baud 
modem from anywhere in the USA, Canada, or Puerto Rico. If you need assistance using the 
Electronic Store, call 800-DIGITAL (800-344-4825). 

Telephone and Direct Mail Orders 

Your Location 

Continental USA, 
Alaska, or Hawaii 

Puerto Rico 

Canada 

International 

Internal * 

Call 

800-DIGIT AL 

809-754-7575 

800-267-6215 

Contact 

Digital Equipment Corporation 
P.O. Box CS2008 
Nashua, New Hampshire 03061 

Local Digital Subsidiary 

Digital Equipment of Canada 
Attn: DECdirect Operations KA02/2 
P.O. Box 13000 
100 Herzberg Road 
Kanata, Ontario, Canada K2K 2A6 

Local Digital subsidiary or 
approved distributor 

SSB Order Processing - WMOjE15 
or 
Software Supply Business 
Digital Equipment Corporation 
Westminster, Massachusetts 01473 

* For internal orders, you must submit an Internal Software Order Form (EN-01740-07). 
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AA-PGL4A-TE 

Please use this postage-paid form to comment on this manual. If you require a written reply 
to a software problem and are eligible to receive one under Software Performance Report 
(SPR) service, submit your comments on an SPR form. 

Thank you for your assistance. 

Please rate this manual: 
Accuracy (software works as manual says) 
Completeness (enough information) 
Clarity (easy to understand) 
Organization (structure of subject matter) 
Figures (useful) 
Examples (useful) 
Index (ability to find topic) 
Page layout (easy to find information) 

What would you like to see more/less of? 

What do you like best about this manual? 

What do you like least about this manual? 

Excellent 
o 
o o 
o 
o 
o 
o 
D 

Please list errors you have found in this manual: 

Page Description 

Additional comments or suggestions to improve this manual: 

Good 
o 
D 
D 
o 
o 
o 
o 
D 

What version of the software described by this manual are you using? 

__________________ Dept. NamefTitle 
Company 

Mailing Address 
___________ Email __________ Phone 

Fair 
D 
o 
D 
o 
o 
o 
o 
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Date 
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o 
o 
o 
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